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Introduction

Introduction

o You will gain the most from this guide by first reviewing it. In addition, be
sure to back up your data.

The goal of the Wind2/Deltek FMS—BillQuick Conversion Guide is to help new users effectively
transfer data from Wind2 software (now Deltek FMS® by Deltek Systems) to BillQuick® (by BQE
Software). With BillQuick, you are equipped with the most powerful time entry and project
management tools in the market. Full-featured, BillQuick Time and Billing helps you manage your
company, whether your time, expense, billing and reporting needs are simple or you require complex
billing, reporting and management capabilities.

Conversion means a one-way transfer of data from one program to another. After Wind2/Deltek FMS
data is converted to BillQuick, you have a single database to work with. You can then archive the
Wind2/Deltek FMS data at your convenience. The Wind2/Deltek to BillQuick Conversion Utility, which is
built into BillQuick, transfers critical information from Wind2/Deltek FMS into BillQuick. This easy-to-use
tool requires little or no manual effort! Compared with a manual conversion, you save days (even
weeks) of non-billable time. You can start using BillQuick sooner!

o Conversion time varies depending upon the size of your Wind2/Deltek
FMS database. During testing, a 100-MB Wind2 database with over 200,000
time entries required 1.5 hours for full data conversion into BillQuick.

How to Use This Guide

We encourage you to review How Data Conversion Works section. Written for users with a non-
technical background, it explains the Wind2/Deltek FMS—BillQuick data conversion process.
Understanding how data transfers will help you visualize what is happening behind the scenes.
Wind2/Deltek FMS to BillQuick Conversion Utility walks you through the entire conversion process, step-
by-step. Finally, Data Flow explains the Wind2/Deltek FMS to BillQuick conversion in detail, including
data field mapping across the two programs.

Software Editions Supported

All BillQuick editions — Basic (Microsoft Access database), Pro (Microsoft Access and SQL Express
database) and BillQuick Enterprise (Microsoft Access, SQL Express and SQL Server database) — can
convert data from Wind2 (version 2003.3.03 or later) or Deltek Financial Management System.

If you have a Wind2/Deltek FMS SQL database, contact BillQuick Support or your Account Rep to have a
BillQuick Consultant do the conversion for you.
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How Conversion Works

How Conversion Works

Understanding the basics of Wind2/Deltek FMS—BillQuick Conversion is important whether you have a
technical background or not. It helps you visualize what is happening behind the scenes as BillQuick
transfers data from your Wind2/Deltek FMS program.

The table below shows the flow of data from Wind2/Deltek FMS to BillQuick. You can be very specific in
determining how and what data flows to BillQuick.

Wind2/FMS Dataflow BillQuick

Table Name Table Name
Labor Codes - Activity Codes
Expense Codes - Expense Codes
Employee - Employee
Client - Client
Project - Project
Time Record - Time Entry
Expenses - Expense Log
Invoice - Invoice
Payment - Payment

|Q| To review detailed, field-by-field mapping of records between
Wind2/Deltek FMS and BillQuick, see BillQuick Help, Wind2/Deltek FMS Data
Conversion, Data Field Mapping.

As you can see above, Wind2/Deltek FMS conversion with BillQuick is very comprehensive. The major
benefit is that you do not have to re-enter Wind2/Deltek FMS data into BillQuick. BillQuick manages the
process, using your conversion preferences.

Conversion Rules

To ensure accuracy and completeness of data transfer, Wind2/Deltek FMS—BillQuick Conversion
follows a set of rules. These are:

1. Backup Data: Back up your Wind2/Deltek FMS databases. Store a copy in another folder
or on a separate storage device.

2. BillQuick Database: Create a new BillQuick database prior to transferring data from
Wind2/Deltek FMS. Enter the required information such as Company Name, License
Key, and Registration Key in the Company screen.
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Conversion Utility

Conversion Utility

Existing Wind2/Deltek FMS users who are new to BillQuick only need to merge data once. From that
point onwards, your time and billing information will be in a single data file (the BillQuick database). In
other words, all your historical information — billed and unbilled time and expenses, paid and unpaid
invoices, payment history — is now in BillQuick. After conversion, you can archive Wind2/Deltek FMS at
your convenience.

Wind2/Deltek FMS to BillQuick Conversion Utility

The Wind2/Deltek FMS to BillQuick Conversion Utility populates your BillQuick Company database with
data from Wind2/Deltek FMS. It automates and controls the conversion, stepping you through the
process using a wizard to simplify the process. The wizard helps you to accomplish tasks that can be
complex for the first time users and require experience.

To convert data from Wind2/Deltek FMS to BillQuick, follow the steps mentioned below:
1. Creating BillQuick Company

As a new BillQuick user, you must first create a new BillQuick company database (see BillQuick Help and
other documentation for more details).

1. In BillQuick, select File, New from the menu. Choose the type of database technology you want
to use. If unsure, choose Standard.

o The database technology available to you depends on the BillQuick Edition
purchased. If you are unsure what edition you licensed, select About BillQuick
from the Help menu. The edition abbreviation displays right after the version
number.

Edition Database Technology
BillQuick Basic Microsoft Access (Standard)
BillQuick Pro Microsoft Access

Microsoft SQL Express

BillQuick Enterprise Microsoft Access
Microsoft SQL Express
Microsoft SQL Server

2. Onthe New BillQuick Data File dialog box, enter a name for your company database. Most
commonly, the company name is used for easy identification. Click the Open button. BillQuick
creates the database and opens the BillQuick Start-Up Interview wizard.
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Conversion Utility

o The BillQuick Start-Up Interview can be closed and reopened later. To do
so, select Wizards, BillQuick Interview from the View menu.

3. On the BillQuick Start-Up Interview page, click the Next button.

4. Leave Business Type blank. If you select a type, BillQuick copies industry-specific activity
(service) and expense codes into your company database. These codes are not needed because
items will transfer from Wind2/Deltek FMS into BillQuick. Click the Next button.

5. Custom Labels allow you to change key business terms to suit your professional and company-
preferences in BillQuick. Customizing terms eases transition from your old time and billing
solution. Select your preferred terms from the drop-down lists. When you have finished, click
the Next button.

6. Onthe Company Name page, enter your company name. Spell it exactly as it appears on your
License and Registration or the Evaluation Key document or email.

-

BillQuick Start-Up Interview Wizard

< >

Help Cancel  Previous Mext  Finish

11

v

v Business Type Business T}r'pE

m Labels BillQuick contains pre-defined Activity Codes for different types of
businesses. You can save time and load a set for your business now, or

o]

“ompany Name skip this option and create a set of work codes in BillQuick later. You
Regional Info can also modify and add to your Activity Codes at any time.
Time Entry Evaluation Computer Consultart]
Smallest Time Increment Accountant -
o o Aerospace Engineer
First Day of Week Architect ‘E
Attomey

Business Consultart
Civil Engineer
Computer Programmer

S Contractor
meslips CPA -

To have BillCwick pre-fill your database with Activity Codes for your type
of business, please select the one that best reflects vour company.

7. Click the Next button to accept the defaults on the remainder of the pages. You can update
these options later in the Global Settings and User Preferences screen. On the last page, click

the Finish button.
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Conversion Utility

8. The BillQuick Initial Setup Checklist wizard displays. This wizard enables the first time user to
create master information (employee, client, project, and so on). Skip this step as you shall
transfer this data from Wind2/Deltek FMS. Click the Close button.

-

BillQuick Initial Setup Checklist

Help Close

BillQuick Initial Setup Checklist

To help vou get started with BillCluick, we recommend vou to complete the following wizards. To exit, click Close.

i Employes

Add Employee to vour company file. The wizard walks vou through each step and makes it easy
to add Emplovees.

. Client
ik
Creates Client profiles. Client information concerning the projects, hours, expenses, billable
amaounts, and cost amounts that vou have generated for each client.

i Froiect
Creates Project profiles. The information recorded to the project record determines how the
project is billed and managed.

S
E Activity Codes

Creates list of activities or tasks for vour company. Activity codes are time-based billable and non-
billable actions performed by timekeepers.

I:G Expense Codes

Create list of expenses for vour company.

9. Next, the Company screen displays. Either complete the fields now and click the Save button
when you have finished, or click the Close button and perform this task later.

10. From the File menu, Bill Quick Login
select Login. For User

ID, type ‘supervisor’
; Hendricks Consulting LLC

'(C\I‘I:I(Ietnh?(;jrtSauS(:\cA?Z)r,d C:\Program Files | \Sample_Datafile2015. mdb
type ‘supervisor’
(without quotes). This
gives you full security
permissions in
BillQuick to perform Remember
conversion tasks.

User ID: | supervisor

Password: axaxa:xaaxl

[ Windows Authentication Cancel OK
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Conversion Utility

2. Backing up Database

Backup both your BillQuick and Wind2/Deltek FMS databases. Store a copy in another folder or on a
separate storage device.

To backup data in BillQuick, select Utilities, Backup Database from the menu. Follow the normal
procedure to back-up your Wind2/Deltek FMS database. Close both programs before proceeding. This
clears internal settings and allows you to start fresh.

3. Converting Data

1. Choose Wind2/FMS Conversion from the File menu.

2. The ‘Wind2/Deltek FMS to BillQuick Conversion Utility’ displays. On the Welcome page, click
Next.

3. Onthe BillQuick Database Type page, select the database you want to use for data transfer.
Select the first option, ‘Automatically detect...” to have BillQuick scan the currently open data

file. Click Next.
k% Wind2 / Deltek FMS To BillCQuick Conversion Utility Iél
< >
Help Cancel Previcus Mext  Finish

BillQuick Database Type

Select the database option you want to use for data transfer. You can choose either
BillQuick Access database or BillQuick SQL Server database. If you want, this utility can
automatically detect the currently used Billduick data file.

@ Automatically detect BillQuick data file.
Open an existing Access database.

Open an existing SQL database.

o If you close and return to Wind2/Deltek FMS to BillQuick Conversion
Utility at a later time, BillQuick remembers the database.

4. By default, the wizard accesses the currently open BillQuick Database. If you want to select

another file, click [ | to browse to its location. Click Next.
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Conversion Utility

Similarly, select the Wind2/FMS Database Name to be used for data conversion. Select the Non-
SQL, SQL (Deltek) or SQL (Wind2) backend option. Wind2 main data file is typically named
DATASET.DBC. Click Next.

e

k% Wind2 / Deltek FMS To BillCQuick Conversion Utility @
<4 >
Help Cancel Previcus Mext  Finish

Wind2 FMS Database Name

This wizard will copy data from your existing Wind2/Deltek FMS data file to BillQuick.
Please select your database backend and data file. Wind2 FMS Mon-S0QL main data file
is typically named DATASET.DBC

Wind2 Database Backend
@ Mon-SQL D) S4L (Deltek) 0 S4L (Wind2)

WindZ FMS Database:

C:\Program Files'\Wind2FMS" Sample FileDATASET.DEC| | | _ |

A

Identify where the Wind2/Deltek FMS Card File is. Wind2 Card File is typically named Sycont.DBF
and located in your Wind2/Deltek FMS folder. Click -] to browse to its location. Click Next.

Before beginning the transfer, you can verify information by clicking Previous on each page.
When ready, click Finish to start the data conversion process.

As Wind2/Deltek FMS data transfers data into your BillQuick company database, a progress bar displays.
It stops automatically and informs you when it the process is complete.
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Data Flow

Data Flow

Data conversion from Wind2/Deltek FMS to BillQuick is completely automated with the Wind2/Deltek
FMS to BillQuick Conversion Utility. However, if you want more details on how Wind2/Deltek FMS data
maps to BillQuick data, please review this section.

|0| For additional information, see BillQuick Help, Wind2 FMS Data
Conversion, Data Field Mapping.

Data Field Mapping

Data is stored in various tables in Wind2/Deltek FMS and BillQuick databases. Below is a list showing the
flow of data from Wind2/Deltek FMS tables (modules) to the corresponding BillQuick tables (modules).

Wind2/FMS Dataflow BillQuick
Table Name Table Name
Labor Codes - Activity Codes
Expense Codes - Expense Codes
Employee - Employee
Client - Client
Project - Project
Time Record - Time Entry
Expenses - Expense Log
Invoice - Invoice
Payment - Payment

The flow diagram shows a different view of the same movement of data.

Master information in Wind2/Deltek FMS flows into the master records in BillQuick. The same occurs for
time and expenses, invoices and payments. BillQuick converts all pertinent data from Wind2/Deltek
FMS, providing familiar and consistent information and production results on the screen and in reports.
While the look and feel is different, the underlying data is the same.

Data fields in Wind2/Deltek FMS map to corresponding fields in BillQuick. Below are the field mappings

between Wind2/Deltek FMS and BillQuick for each data table (module). The tables below include
default values that transfer from Wind2/Deltek FMS to BillQuick.
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Data Flow

Wind2/FMS Dataflow BillQuick
Employees Employee
Employee ID - Employee ID
Last Name + M| + i Last Name + Ml +
First Name First Name
Hourly Billing Base - Bill Rate
Rate
Hourly Cost Rate - Cost Rate

o You may notice an Employee ID ‘FromWind2’. BillQuick automatically
creates this employee record for time and expense entries transferred from
Wind2/Deltek FMS if they are not against a specific employee. These entries
are associated with this special Employee ID to ensure compliance with

BillQuick data requirements.

Wind2/FMS Client

Dataflow BillQuick Client

Client ID
Name
Address [associated card file]
Address [associated card file]
City [associated card file]

State/Province [associated card
file]

Country [associated card file]
Postal Code [associated card file]
Fax [associated card file]

Inactive (check box)

- Client ID
- Company
- Street
- Street2
- City

- State
- Country
- Zip

- Fax

- Status

Wind2/FMS Labor Dataflow BillQuick

Code Activity
AR Code
Labor Code Sub
(if Time Off code, Billable:
it is set to non-billable)
Setto 0 Bill Rate
Setto O Cost Rate

Wind2/Deltek FMS—BillQuick Conversion Guide 2015 v.1
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Data Flow

Wind2/FMS Expense  Dataflow BillQuick Expense

Code
Expense Code ID - Code
Description - Description
Billable Status: - Cost
Billable/Ignore/Override
Classification: - Billable
Inactive/Closed, Open

Multiplier* - MU%

Inactive - Inactive

*In Wind2/Deltek FMS, there are two ways to markup the expense, using a multiplier and a markup. When the
figure is transferred to BillQuick, the MU percentage is calculated using both values.

Wind2 Projects Dataflow BillQuick Project
Project ID - *Project ID
Title - Name
Client - Client
Inactive/Completed (check box) d Status
Hourly by default - Contract Type
SetasO - Contract Amount
SetasO - Service Amount
Setas O - Exp Amount
Default date of data - Start Date
Creation in Wind2
SetasO - % Complete
Manager* - Manager
State [associated card file i State
attached]
City [associated card file - City
attached]
Postal Code [associated card file - Zip
attached]
Country [associated card file - Country
attached]

*Erom Wind2/Deltek FMS, where no specific manager is attached to the Project.
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Data Flow

Wind2/FMS Time Dataflow BillQuick Time
Records Entry
Timekeeper - Employee ID
Project - Project ID
Lab Code - Activity
Bill Hours - Hours
Bill? - Billable
B? (checked) - Approved
Date - Date
OT Hours* - OT (check box)
Comment** - Description

*In BillQuick, a separate time entry is made for overtime hours and the OT Flag is checked.
**If the Comment field is not filled, BillQuick transfers the description of the activity labor code.

Wind2/FMS Dataflow BillQuick Expense
Expenses Log
Employee ID (or - Employee ID

FromWind2)

Project - Project ID
Transaction - Exp ID
Unit Cost - Cost
Bill? * (yes) - Billable
Billing Status: - MU

Billable/Override,
Do not Bill/No Charge
Charge - Amount
Comment - Description
Date - Date
Bill Units - Units

*In Wind2/Deltek FMS, you can markup the cost using Unit Markup and/or Multiplier. When transferring data
from Wind2/Deltek FMS to BillQuick, it calculates the MU based on both the figures.

Wind2/FMS Dataflow BillQuick
Invoices Invoice
Invoice Number - Inv #
Invoice Date — Date
Project - Project ID
Invoice Amount — Amount
Invoice Balance - Balance
Total Paid - Paid
Client - Client ID

Wind2/Deltek FMS—BillQuick Conversion Guide 2015 v.1
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Data Flow

Wind2/FMS Dataflow BillQuick
Payments Payment
Client - Client ID
Project - Date (payment)
Invoice - Amount
(Payment)
Project Name - Memo
Date Paid - Date
Payment Type - Pay Method
Amount - Amount
Check # - Reference
Notes - Memo
Balance - Balance
Project - Project ID
Invoice - Invoice No
Date Paid - Date
Amount Paid - Paid
Balance - Balance

Congratulations! You have now an understanding of data flow from Wind2/Deltek FMS to BillQuick and
how to ensure that the data transfer is accurate. To learn more, check the BillQuick Help.

For more information, visit us at www.bge.com.If you have any trouble in using the conversion tool,
please contact BillQuick Support at (310) 602-4030 or Support@bge.com. For other questions, please call
us at (888) 245-5669 (US and Canada) or (310) 602-4020; or email Sales@bge.com.
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@ BQE Software, Inc.

World Headquarters

NORTH &SOUTH AMERICA
3825 Del Amo Blvd.
Torrance, CA 90503
USA
Tel: (866) 945-1595 (toll-free) | +1 (310) 602-4010
Email: sales@bge.com | support@bge.com

AUSTRALIA, NEW ZEALAND & ASIA

Suite 7 255 Broadway
Glebe, New South Wales 2037
Australia

Tel: 1300 245 566 (toll-free) | +61(02) 92497327
Email: aus-sales@bge.com

EUROPE, MIDDLE EAST & AFRICA

Crosshaven Co.Cork
Ireland

Tel: +44 2034119852
Email: uk-sales@bge.com

For more information, visit: www.bge.com
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